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If this file fails to resolve any problems you are having, you can contact our technical support 
team at:

800-356-5590 (voice)
203-797-6872 (BBS - see below for more info.)
203-797-3835 (FAX)
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System Requirements

Computer: 486DX or higher, 33 MHz or faster

Operating System:  Windows 3.1 or higher running on DOS 5.0 or higher

Memory: 8 MB of RAM

Hard Disk: 5 MB free hard disk space

Video: 256 color SVGA and color monitor (SVGA)

Audio: Windows-supported sound card with associated drivers

CD-ROM Drive: MPC II rated double-speed CD-ROM drive (300 KB/sec sustained data-
transfer rate)

Mouse: Windows supported mouse or pointing device

Ancillary Software:  QuickTime for Windows 2.0.3 (supplied with product)
MSCDEX version 2.2.1 or higher (not supplied with product)



Installation

1.  Select Run from the File menu.
Windows 95 users select Run from the Start menu on the Task Bar.

2.  Type D:\SETUP (where D is the CD-ROM drive letter) and press Enter.

3.  Follow the on-screen instructions.

4.  Double-click the How Would You Survive? icon to run How Would You Survive?.

Please note:  The setup program for QuickTime for Windows installs QuickTime files into your 
WINDOWS and WINDOWS\SYSTEM directories.  Please see the Manual Installation (below), 
steps 6-8, to run just the QuickTime installation.  

Manual Installation

It is highly unlikely, but in the event that the SETUP.EXE program fails to complete the 
installation, the following directions can be used to set up How Would You Survive? manually:

1.  Exit Windows to DOS.
Windows 95 users select Programs from the Start menu then select MS-DOS prompt.

2.  Create a new directory on your hard drive called SURVIVE. 
  a.  From the root directory of C (C:\>), type MD SURVIVE <enter>.

3. Copy the files listed below from the How Would You Survive? CD to your 
SURVIVE directory (where D: is the drive letter of your CD-ROM drive).

  a.  Type COPY D:\INST\FILEIO.DLL C:\SURVIVE <enter>.
b. Type COPY D:\INST\SURVIVE.EXE C:\SURVIVE <enter>.
c. Type COPY D:\INST\SURVIVE.ICO C:\SURVIVE <enter>.

4. Create the SURVIVE.INI file in C:\SURVIVE.
  a.  Type CD\SURVIVE <enter>.
  b.  Type EDIT SURVIVE.INI <enter>.

 c.  The screen will be blank when you first enter the DOS editor.  Type the following  
two lines:

[SOURCEDRIVE]
THECDROMDRIVEIS_=D:\

(Where "D" is the letter of your CD-ROM drive.)

d. Save the edited INI file.
Click File then Save.



e. Exit the DOS editor.
Click File then Exit.

 Windows 95 users please see below for step #5*
5. Make a program group and program item for How Would You Survive?

  a.  Start Windows.
  b.  From Program Manager, click File, New, Program Group,  OK.
  c.  For the description, give the program group a name, such as Grolier Kids.
  d.  Click OK.

 e.  From Program Manager, click File, New, Program Item, OK.
  f.  For Description, type How Would You Survive?.

g.  At the command line type C:\SURVIVE\SURVIVE.EXE (assuming the 
program was installed to C:\SURVIVE).

h. Click Change Icon and double-click on the icon you wish to use.
  i.  Click OK.

* Windows 95 users:
5. Make a new folder for How Would You Survive?

a.  Exit the MS-DOS window.
b. Choose Settings from the Start menu.
c. Choose Task Bar.
d. Click on the Start Menu Programs tab.
e. Click on Add.
f. On the Command Line type C:\SURVIVE\SURVIVE.EXE then click Next.
g. Click New Folder.
h. Type Grolier Kids for the new folder name.
i. Click Next.
j. Type How Would You Survive? for the name of the shortcut.
k. Click Finish.
l. Click OK.

Install QuickTime for Windows (if it is not already installed):

6.  Select Run from the File menu.
Windows 95 users select Run from the Start menu on the Task Bar.

7.  Type D:\Inst\QTINSTAL.EXE (where D is the CD-ROM drive letter) and press Enter.

8.  Follow the on-screen instructions.

9. Double-click the icon to start How Would You Survive?.
Windows 95 users select Programs from the Start menu.  Then choose Grolier Kids then 

How Would You Survive?.

Notes on the SURVIVE.INI File



The SURVIVE.INI file is created during install and resides on your hard drive in the SURVIVE 
directory. The following describes the content of the SURVIVE.INI file should you ever have 
reason to modify the file manually.

[SOURCEDRIVE]
CDROMDRIVEIS_=D:\

Where "D"  is the drive letter of the CD-ROM drive on which How Would You Survive? will be
located.  (Should the letter of your CD-ROM drive change, this line should be edited to reflect 
the new letter of the drive.)

Game Playing Tip
How Have You Survived?

If you would like to play the game a little quicker and do not want to go to the subject screens to 
find the answer, you can use the SHIFT key option.  Hold the SHIFT key down and click on the
tile of the question(s) you answered incorrectly and you will get a second chance.

Troubleshooting

General

We do not anticipate you will have any problems using this CD-ROM.  However, you should 
check the following items if an error does occur:

1. Make sure the correct CD-ROM is in the CD-ROM drive and that the drive is turned 
on.  You cannot use How Would You Survive? unless the CD-ROM is in the CD-ROM 
drive.

2. Verify that your equipment meets or exceeds the System Requirements (above).

3. Ensure that you are not running any other applications in the background.

4. Try restarting your computer.

5.  Try deleting the SURVIVE directory and re-installing the product.

6.  Try using a different video display resolution.  For example:  If you are running 
Windows in 800x600 try 640x480.  If your video card allows a choice of  "large font"

or "small font", choose "small font".

7. Try using a lower number of colors for your video display.  For example:  If you are 
running Windows in millions or thousands of colors, try 256 colors.



8. Try to obtain the most recent drivers for your video card, sound card and CD-ROM 
drive.  The positive effect this has can be profound.  At the end of this file, there is a 
list of contacts for video drivers.

Memory Issues

If you get an error message at startup indicating that you need to increase the amount of memory 
available, check to be sure you have the required 8 MB of  RAM (not including any virtual 
memory).  If you do have the required amount of RAM and you continue to get a memory error 
message at startup, follow the steps below:

Windows 95 users, it is recommended that you not change your swap file settings as Windows 95 
controls the size of the swap file based upon need.

1.   From Program Manager open the Main program group.

2.   Double-click the Control Panel icon.

3.   Double-click the 386 Enhanced icon.

4.   Click  the Virtual Memory button.

5.   Click Change.

6.   Enter a new (larger) value, then click OK.
    You will probably need to set virtual memory somewhere between 4000KB and        

8000KB to run How Would You Survive?.  We suggest you start with a value of  
8000KB.  If Windows will not accept this value, try entering a lower value until 

Windows will accept your entry.

(You will probably be able to select a larger value if you select a Type of  Temporary in the 
list box on this screen.)

7. Click  Yes to confirm that you want to change the Virtual Memory settings.

8. Restart Windows for the change to take place.

9. Run How Would You Survive?.

10.  You may need to repeat steps 1-9 until you find a value for virtual memory that 
 works.

Installation

If you get the error message "Not enough space on the drive.  Try another." during the 



installation of  How Would You Survive?, make sure that you have a drive letter and 
directory indicated in the Installation Location window.  If the message appears again 

during 
installation check the amount of disk space available on the drive you're trying to install to.
To do this go to the DOS prompt (C:\DOS ) and type CHKDSK. 

Minimize Grolier Kids Window

If the Grolier Kids window is maximized every time you start Windows (version 3.1 or 3.11):

1.  Minimize the Grolier Kids group:
a.  Click the "down arrow" in the upper right hand corner of the window.

or
 b.  Click on the  "minus" sign in the upper left hand corner of the window 

then click Minimize or Close.

2. Choose Save Settings on Exit from the Options menu in Program Manager.

3. Exit Windows.

4. When you re-start Windows, the Grolier Kids group will be minimized.

Display problems

If your system has display problems, but meets the stated system requirements and you have 
obtained the most recent drivers, you can try the following:

1. Modify the QTW.INI file located on your hard drive in the Windows directory.  
a. Save a copy of the original QTW.INI with the extension OLD (QTW.OLD).
b.  Create a new file.
c.  The new file should contain the following two lines:

    [VIDEO]
    Optimize=Driver

d.  Save the file as QTW.INI.
e.  Try How Would You Survive? again.
f.  If this fails to work, you should try replacing the word Driver with BMP.  

You can also try RAW or DIB in place of  Driver.

2. The QuickTime for Windows Readme file, accessible from the QuickTime for 
Windows program group, contains information on QuickTime, including a list of 

incompatible hardware and instructions on how to modify the QTW.INI file.

Problems with specific video cards



1. ATI Mach64 video card

Users of this video card may encounter problems with QuickTime.  This can often be 
resolved by adding a line to the [MACX] section of  your SYSTEM.INI file.  The 

line you add to the [MACX] section should read:

DeviceBitmap=OFF

If this line is already there, please be sure there is no "s" at the end of Bitmap.

2. Trident and Headland Technology video cards

Modify the file QTW.INI.  Please see above for instructions on how to do this.  Use the 
Optimize=BMP line.

3. Diamond Stealth 64 video cards

Modify the [STLTH64] section of your SYSTEM.INI file.  The line you add to the 
[STLTH64] section should read:

DeviceBitmaps=0

The Grolier BBS

General Information about the Grolier BBS

Contact Grolier by modem 24 hours a day!  Grolier Electronic Publishing is offering a Bulletin 
Board Service (BBS) to better meet your technical support needs.

You can use the BBS to send our Technical Support team messages concerning any problems you
encounter.  In most cases, you will receive a response to your question within one working day.  
To read our response to you, simply call the BBS the next day.  If we have responded, you will 
automatically be notified at the time you connect.

Please remember the ID and PASSWORD you use when you leave us your message.  In order to
receive your reply, you will have to log-on using the same ID and PASSWORD.

What You Need To Know to Connect

Our BBS number is 203-797-6872.  You will need a 2400bps or higher speed modem to access 
the board.  Set your communications software to DATA BITS=8, PARITY=N, STOP BITS=1.

Don't forget that Windows 3.1 comes with a communications program called Terminal that you 
can use to log on to the Grolier BBS.  The Windows 95 communications program is called 



HyperTerminal and is located in the accessories group.

Grolier on the Internet

Grolier's Web site, "Grolier Online", offers visitors in-depth information about Grolier products.  
The Internet address is www.grolier.com.

For technical support choose the e-Pub icon on Grolier's home page then choose Customer 
Help Desk.  In this area you will find information on the most common technical support issues. 
In the future you will be able to send the technical support team electronic mail messages 
concerning any problems you encounter.

Contact List for Video Drivers
(Updated 08/23/95)

Phone BBS Internet

ATI Technologies 905-882-2626 905-764-9404 www.atitech.ca

Cirrus Logic 800-764-7200 510-440-9080 ftp.cirrus.com

Compaq Computer Corp. 800-652-6672 713-378-1418 www.compaq.com

Diamond Multimedia
Systems 408-325-7100 408-325-7080(2400) www.diamondmmm.com

408-325-7175(9600)

Hercules Computer
Technology 510-623-6050 510-623-7449 www.hercules.com

Number Nine Corp. 617-674-8595 617-862-7502 www.nine.com

Packard Bell 801-579-0161 801-250-1600 www.packardbell.com

Trident 415-335-1179 415-691-1016 www.tridsys.com

TSeng Labs 215-968-0502 215-579-7536


